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Before using this information, be sure to read the general information under the “Notices” section 

on page 43. 
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Welcome 
Welcome to the CSV Walkthrough for IBM Rational Dashboard! 

 

IBM Rational Dashboard brings software management best practices within reach of every 

organization and every manager.  Manage requirements, schedule, budget, quality, configuration 

management and size in one place; keeping total control of the drivers that keep projects on time 

and within budget.   

 

IBM Rational Dashboard spans the gap between the management process desired and the one 

currently in place.  Focus on managing by exception using IBM Rational Dashboard alerts, 

analysis, graphical displays and drillable views that provide all the information needed to make 

well-informed decisions quickly.  Using a web-based interface and intelligent integrations to 

software life cycle tools, IBM Rational Dashboard delivers industry best practices ready to be 

applied.  Finally, IBM Rational Dashboard checks project compliance with industry standards and 

unit templates, ensuring a course to success.  
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Data Collection Overview 
 

Before beginning the integration to a data source, it is important to understand the key elements 

that allow the portal to gather and display data from your data.  

 

Data in the Portal is gathered by the Collector, configured by the Interfaces, organized by 

Information Needs and analyzed in the Organization Tree. 

 

 
 

The Collector (Windows based executable) - Gathers data from outside sources and stores it in 

the Transform database.  

 Outside Data Sources include: IBM Rational DOORS, IBM Rational Synergy, IBM Rational 

Change, Rational ClearQuest, Microsoft Project, Oracle Databases, Microsoft SQL 

Databases, Microsoft Access, Microsoft Excel, ODBC, CSV, and HP Quality Center.  

 The Transform is a Microsoft SQL Database table located in the Dashboard_Transform 

database. It stores current and historical data collected from Outside Data Sources. 
 

Interfaces (From the Collection tab in the Portal) – Allow users to define and organize data 

collected by the Collector.  Interfaces are defined using three subtabs: General, Fields and 

Queries. 

 The General tab includes the type of data being retrieved from the Outside Sources as 

well as the name of the database that will be used to store the data. 

 The Fields tab defines the field sets of data that are being retrieved as well as the table 

name where information will be stored in the Transform. 

 The Queries tab indicates the SQL queries that will be run against the Transform to 

produce data points for Graphs. 
 

Information Needs (From the Library tab in the Portal) – Allow users to define graphs to display 

the collected data. 

 Graphs contain Series that are used to plot data against time/events. 

 Series are associated with Queries defined in Interfaces to determine which data to plot. 

 Information Needs can be used by one or more interfaces. 
 

Organization Tree (From the Status tab in the Portal) – Allows users to display and analyze data 

in Graphs which are defined in Information Needs. 

 Folders and Units provide structure for the Organization Tree. 

 Units can contain one or more Information Needs. 
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 CSV Sample Walkthrough 

 

This sample describes the necessary steps to configure and collect data from CSV files.  This 

sample walks a new user through all required steps needed to see graphs with data points 

populated from CSV files. 

There are four areas that will be covered through this walkthrough: 

 Formatting the CSV File 

 Portal Configuration 
o Examine/Configure an Information Need 
o Create an Interface in the Portal 
o Setup a Unit with Information Needs (or use a template) 
o Assign Schedules to a Unit 

 Collector Configuration 
o Configure the Collector 
o Run a Collection 
o Check/Resolve any collection errors/problems 

 Unit Configuration 
o Check for collected items in the Portal and assign them to Units 
o Refresh the Unit 
o View collected data graphs in the Portal 
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Formatting the CSV File 
 

The Portal requires that a certain format be applied to the CSV file.  This format is the basic 

format applied to CSV files, so most exported files will be compatible.  The format requires that 

the first line of the file be the “column” headers, or the definition of what is in the file.  For 

example, in the Schedule CSV file that will be used as an example throughout, the header line 

looks like the following: 

ScheduleMilestone,Task_Start_Date,Task_Finish_Date,Task_Act_Start,Task_Act_Finish 

Notice that there are commas between each field, and no comma at the end.  The header line 

should be on a line by itself.  Each consecutive line should have data that lines up to the fields in 

the header, is separated by commas, has no comma at the end of the line, and be on a line by 

itself.  This is the basic format that the Portal is expecting.  Once your CSV file is set up correctly, 

you are ready to move on to configuring the Portal. 
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Portal Configuration 

The Portal provides the user the ability to describe which data to collect, how to analyze it and 

then how to display it.  Before information can be analyzed or displayed, the Portal must be 

configured to collect the information from a CSV file. 

 

  

Examine/Configure an Information Need 

Upon opening the application, the Portal defaults to the Status page.  Click on the Library tab and 

select the Information Need List option.  This will open the list of Information Needs that are 

currently available for use.  For this example, we’ll create a new Information Need, though we 

could use an existing one.   

Adding an Information Need 

From here, click on the add button above the list.  On the general subtab, name your 

information need and choose a state for the Information Need that you are creating.    

 

All other information on the general subtab is optional.  Additionally, the information on the 

reference and guidance tabs are for use within your company, generally for conveying 

information about an internal metrics plan, or utilizing best practices that have been collected 

when you’re reviewing and creating a metrics plan.  Save the Information Need and then reopen 

it.  This is done so that no data is lost when you create a graph in the Information Need. 



 

© Copyright IBM Corp. 2004, 2009   
8| 

 

Adding a Graph to the Information Need 
 

Within the Information Need, you have the ability to add graphs that are all related to the 

information area associated with an Information Need.  One or more graphs can be added.  The 

drop down fields on the graph subtab will be addressed later.  To create the graph, select the add 

button on the graphs subtab. 

 

 
    

Selecting the add button, opens the Library Graph window for the new graph.  The Library graph 

window defaults to the graph subtab.
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On the graph subtab, all of the basic information about the graph is set.  Enter a name for the 

graph in the Title field.  The Description field may be left blank or filled in as desired.  The Type 

of graph is chosen from a drop down list.  We will be using a run graph for this example.  (For 

more information on graph types, see the help files.) 
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Next, a frequency needs to be chosen.  There are two options available for this field: schedule-

driven or event-driven.  An event-driven graph does not have a pre-defined and consistent 

schedule.  Examples of event-driven frequencies may include software releases or peer reviews.  

Schedule-driven graphs are based on a static and consistent schedule, such as a daily, weekly, 

or monthly data collection.  The selected graph schedule is used to populate the information on 

the x-axis of the graph.  If no schedule is selected, the graph will default to the same schedule as 

the item to which it is assigned.  This is the option that will be used for this example. 

  

Finally, there is the Status option.  A change to this option would be necessary for one of two 

reasons: more than one alarm on the graph or to inhibit the status of this particular graph from 

affecting the status of the Information Need as a whole.  For this example, the status will be left 

at the default selection, worst-case of all alarms.   
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To add a series to the graph, select the series subtab.  This is where the information that will be 

displayed on the graph is going to be displayed.  The example graph will be very basic and will 

include three series: Actual, Plan, and Alarm.   

 

To create the Actual series, click on the add button.  Enter the name of the series, Actual Tasks, 

in the Title field.  This series is a Data type series, and is an Actual duration, meaning that it 

should only show data from a given date, backwards.  It is a Normal series, and for the source 

select the single series query radio button.  Save the series.   
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Create a second series and call it "Planned Tasks".  Again this series is a Data type series, but this 

series is going to use the Plan duration, which means that it can have data for both before and 

after the current date.  This series is also normal, and we will leave it as a manual entry series.  

Click the save button to save the series. 

 

 
 

Now create a third series and call it "Total Tasks Alarm".  This series is going to be an Alarm type 

series.  Select Actual for the Duration and Normal for the Use.   

 

For this series, the source is going to be an equation, so select the equation radio button.  In the 

equation box, type if((series("\Actual Tasks")>series("\Planned Tasks")),red,green).  (Do not 

copy the query out of this document as Word documents change the quotation marks to an image 

character that is not accepted in the equation.)  After you’ve saved the series once, you can also 

use the Equation Editor to create or edit the equation for the alarm.   
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For the equation in this example, the alarm shows red if the total number of tasks is more than the 

planned number of tasks.  

 

 

  

Once you've created all three series, save the graph.   
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The final step in configuring an Information Need is to set the Information Need status drivers, 

using the dropdown fields on the graphs tab.  These three areas drive the status for the Status 

page displays.  In this case, set the Actual Tasks series as the Current Actual value, Planned 

Tasks as the Current Plan value, and the Total Tasks Alarm as the Current Status value.  Save 

the Information Need. 

 

 
 

Now that the Information Need is configured, let’s create an interface.  
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Creating the Interface in the Portal 
 

The next step is to create a unique Interface for the CSV file.  Select the Collection tab, and then 

click on the Interfaces option on the left hand side.   

 

From the Interfaces List, click on the add button.  This will create a new Interface.  An Interface 

includes the type of information that will be collected from the data source (in this case, fields 

from a CSV file), where the information will be stored as well as the queries that can be executed 

against the data collected.     
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On the general subtab of the interface, enter a name for your interface.  The name for this 

example is Schedule CSV.  For CSV files, the Description and Type Identifier are optional fields 

which will not affect the collection.  Select the Database where the collected data will be stored.  

This is normally the Transform Database.   

 

The next step is to set up the fields in the Interface. 
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Setting Up the Fields 
 

The Collector uses the information found in the fields subtab of the interface to determine what 

information to collect.  Select the fields subtab.  Notice that it is possible to have multiple sets of data 

collected from this tab.  This is mainly used for database type sources that collect information from 

multiple tables and will not be used with CSV files.  The Default set should be used, but can be 

renamed if desired by changing the Title. 

 

On the left side of this page, enter the name of the database table where the data will be stored.  For 

this example, we will use “ScheduleCSV”.  The Parameter Replacement Tag field is also mainly used for 

database type sources and will not be used for CSV files.  To save any changes to the Title or Database 

Table fields select the Apply button under the Parameter Replacement Tag field.   

On the right hand side, you will input a list of columns from the CSV file to be collected by the Portal.  

For CSV files, each column heading should be added as a field.  When you add a field, you are asked 

for a few pieces of information.  The first is the Source Attribute.  This value is what the column name 

is in the CSV file.  For this example, we’ll use the last column in our file, which is named 

task_act_finish.  Below the Source Attribute, you see the Table Field.  This is what the column in the 

database will be named; in this case we’ll use TaskActFinish, though it can be the same as the Source 

Attribute.  The only requirement for the Table Field is that it be unique for this table and that it follows 

SQL Server naming convention which means no spaces in the word.  

  

The next item to fill in is the Type of field that you’re collecting.  This will be used in creating the 

schema for the database.  Make sure that the type that you choose here is equivalent to the Source 

type.  For example, since the task_act_finish is a date, you would choose either DateTime or Date as 

the Type.  Finally, the Value area lets you determine how to handle null values.  You can choose to 

allow the field to have nulls (blanks) as acceptable values or disallowing nulls.  If you choose to not 

allow nulls you are required to input a default value that is the same type of value as you choose for 
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the Type.  For example, if we wanted to not allow task_act_finish to be null, you could use “3/18/2007” 

for the default value, but not “today”.  Once you’ve completed setting up your field, click the save 

button below the field to save any changes.  

    

Once you’ve created your field, you cannot make any changes to the field except to change the Source 

Attribute value (if you incorrectly entered it or the value changes).  Once you’ve finished adding all of 

the Fields from the CSV, you’re ready to move on to writing queries for your data. 

 

Defining Data Queries 
 

The final tab of the Interface is the queries subtab.  The queries tab is used to define how data is 

counted or treated to show the information that is desired.  This is done through SQL queries, 

with the help of a handy Query Builder.  Most of the queries can be built with little or no 

knowledge of SQL, though cursory knowledge would definitely be helpful for troubleshooting.   

The first step is to create a Query.  You have a choice of two types of queries: single series and 

multiple series.  A single series query returns a single value for one series in a graph and is the 

more common query to use.  Multiple series queries are used when you’re either not sure of what 

data you’re going to be collecting, or you’ll be running the same basic query with a single 

difference.  For example, if you wanted a graph that would display Defects by Priority, but you 

weren’t sure how many different priorities were being used, you could use the multiple series to 

first retrieve the different priorities, use those to create series for a graph and then count the 

number of defects for each priority.  Or if you knew the priorities, but there were a good number 

of them you could use the multiple series query for the same use. 

 

In this example we’ll create a single series query.  Click the add button for the single series 

query.  
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Notice the new query created below. 

   

Enter a name in the Title field that will be meaningful when it is used at a later time.   

For this query, the information that we want to get is a count per period of all of the tasks in the 

file, but only for this one file.  To get this, select the radio button for a count of, and click both 

the check boxes for the current item (which restricts the data collection to just this one file) and 

for the current period (which restricts the data collection to the data collected for the specific 

time period).  Most of the time, you will want to use the check boxes for both the current item 

and the current period. 
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Use the Edit Query breadcrumb to return to the query builder.  This query is now complete and 

can be saved. 
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You can create other queries to provide a different count of data from the CSV interface, using 

different fields/columns or different selection terms. (For more information on setting up queries 

in the Portal, check the help files.) 

 

Assigning Interface Queries to a Library Series 
 

To enable data to be populated in a series, each series must have one or more interface queries associated 

with it. Once a query is associated with a series, the query is run after data collection to provide a data point 

for the series. Because a graph in the library is not specific to one interface (that is, a graph may have more 

than one interface that can provide data for it), you may select multiple interface queries for one series.  So, 

you may assign a query from more than one interface to the same series in the Library. When the graph (that 

contains the series) is created in a Unit, the associated interface query is used.  

For series with a data source of single-series or multi-series, you will see the number of Interface queries that 

have been assigned, and you can click on the “Select Queries” button to assign queries.  If the Select Queries 

button is not enabled, make sure the source is single-series or multi-series (as appropriate) and then press the 

Save button.  To simplify the process, the Portal provides you with the ability to either 1) assign series to 

queries or 2) assign queries to series.  You can access this from either the Library Graph page (see next image) 

or the queries sub-tab in the Edit Interface page (see image above).   
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The Assign Series to Queries page allows you to assign one of more queries to a series in the Library. This page 

has two sub-tabs described below.  Once you are done with the assignment, use the breadcrumbs at the top of 

the page to return to previous page.  

 

On the “to query” sub-tab, you may select a series from the Library (select an information need and then a 

graph/series from the drop downs) and then review a list of Interface queries, if any, that have been assigned 

to the series. You may select an interface from the (lower) dropdown, and then assign one of the Interface 
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queries to the currently selected series.  This sub-tab is designed to review all the interfaces that a single series 

has been assigned to.  

 

On the “to series” sub-tab, you may select an information need and interface and then assign or un-assign the 

series to queries as needed. This sub-tab is designed to help assign all the queries in an interface at one time to 

the series in one information need. Below, the “Total Tasks” query from the Schedule CSV interface has been 

assigned to the “Actual Tasks” series of our new graph. Notice that the button on the appropriate column 

(below) now says “Unassign” indicating that has already been assigned. 

 

When you have finished assigning queries to a series, or reviewing them, you use the breadcrumb 

to return to the previous page.  

 



 

© Copyright IBM Corp. 2004, 2009   
24| 

 

Set Up a Unit 
 

Once you’ve finished configuring the Information Need and Interface, it’s time to set up a Unit to 

display the results you’ll get from data collection.  Begin by adding a new Unit. 

 

Head back to the Status tab.  To add a unit, click on the Edit subtab.  This is where your data tree 

gets organized.   

 

Create a folder, or use an existing one, and click the add unit button.  On the right hand side, 

you will see information about the Unit that you’re adding.   
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Give the unit a title, and set an owner (this value can be changed later).  You can leave the 

template set to no selection since no template has been setup for the new interface.  A template 

automatically assigns Information Needs and other information to your Unit and can be used to 

easily create homogenous units.   

 

Click the Add button.  Now that you’ve created a unit, you’re ready to assign a schedule to the 

unit. 
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Assign a Schedule to a Unit 

The schedule assigned to a unit becomes the default schedule for any items assigned to the unit 

as well as the graphs associated with them.  The unit schedule is used in the Gantt View to 

determine the time period shown.  The unit schedule is also used to update the status of the unit.  

 

To assign a schedule, first go to the Status tab’s View subtab and select the unit.  Then click the 

Details and status icon.  This will open the Unit Status page with the Gantt view displayed.  

Under the Definition section, select the Unit Properties option.  The Unit Definition screen will 

open for the selected unit.  Notice, the Schedule field is already set to basic schedule mode.  

Select Monthly Schedule 2008-2010 from the dropdown list.  In the Dates fields, enter a Start 

Date and End Date for the schedule.  Remember to save any changes to the schedule by 

selecting the Save button. 

 

 
 

At this point, you’re ready to configure your Collector and collect your data.
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Configuring the Collector 

 

Open the Collector using Start >Programs>IBM Rational>IBM Rational Dashboard>Dashboard 

Collector. 

 

The next step is to verify the connection to Web Services. 
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Verify Connection to Web Services 
 

The Collector uses the Web Services to communicate with the Portal.  To verify your connection to 

the Web Services, click File, Options from the menu bar.  By default the IBM Rational Dashboard 

Web Services URL is set to: 

http://localhost/DashboardWS 

If you are running the collection from the server that is running the Portal then “localhost” will 

work fine.  If you are running the collection from a machine other than the Portal server you will 

need to change the “localhost” part of the URL to the name of the server running the IBM Rational 

Dashboard Portal.  Be sure to click the “Apply” button if you make any changes. 

Click the test button to test the connection. 

 

 

If after pressing the "test" button, you receive an error or warning message.  Review the message 

and your web services configuration to correct the problem.  The web services configuration 

information is contained in the web.config in the Web Services folder. 

 



 

© Copyright IBM Corp. 2004, 2009   
29| 

Add a Source 
 

Choose sources/add from the left menu.  Select CSV as the Tool, and give your source a name. 

You will notice a drop down list of Interfaces below the Tool selection.  This is used for to delineate 

between different instances of a tool and let the Collector know which Interface to use when 

collecting from a specific source.  You’ll want to select your CSV Interface from this drop down.  

Once you’ve done that, click Add. 

 

The next step is to setup the collector. 
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Set Up the Collector 
 

The setup for a CSV requires some basic information about the file.  First of all, there are several 

ways to bring in a CSV file.  The first is “All Files in a Folder”.  For this option you chose a folder 

in the file system and the Collector will try to collect the fields that you set up in the Interface 

from all of the CSV files in that folder.  One use for this would be if the same report was coming in 

from several different projects but had the same structure and similar data.  In this case you 

could have all of the projects put their files in the same folder and the Collector would collect 

them individually.  The folder that the files are in should be selected as the “Folder of CSV Files”. 

 

 

 
 

The second option is “Use Listing File”, which uses a file called list.txt file to list all of the files to 

collect.  Each line in the listing file consists of a title in double quotes of the item as it will be seen 

in the Portal, followed by the full path to the file.  
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An example is show in the image below. 

 

 
 

You must create this file and choose which folder this file is contained within. 

 

The final option is using “Date Stamped Files in a Folder”.  This option allows you to put files in 

a given folder that have a date stamp on them showing when they should be collected for.  The 

format for these file names should be <filename>_yyyymmdd.csv.  The dates should match the 

Collection date for the schedule that is assigned to your item.  The default schedule has a 

collection date of the last day of the month, so an example would be schedule_20070131.csv, 

which would have data for the month of January in 2007. 

 

Be sure to save your settings by clicking the save button in the bottom left corner. 

 

 
 

The next step is to run a collection. 
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Running a Collection 
 

Once you’ve saved your configurations, you’re ready to run your collection.  Go to the control link 

in the Collection section.  Click the radio button for One Source and select your CSV source from 

the drop down on the right.  Below the drop down, select “Specified Date” and choose the last day 

of the previous month.  The default schedule for the Portal is a schedule that collects data on the 

last day of the previous month, so selecting this date will let you automatically see data in your 

graphs once the default information is applied.  See the Help files for more information about how 

schedules affect the Collector.  

Once you’ve picked your source and your date, click on the start button.   

The Collection Progress page will appear and you will be able to track your collection as it runs.  

You’ll see in the details on the bottom them number of items and containers that were found 

and see how far you’ve gotten through the collection.  

 

Once your collection finishes, the summary box at the top of the collector will tell you information 

about the collection itself, how long the collection took, how many items were collected, how 

many rows were inserted into the database tables and how many errors were encountered, if any.  
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If your collection does have errors, you can click on the “View Log File” link at the bottom of the 

progress page.  This will open up the log file (which can also be reached under the File menu).  

This log file gives you information on why a module may not have been collected.   

 

The next step is to configure the unit. 
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Configuring the Unit 
 

Assigning Collected Items 

 

Once you’ve run your collection without errors, you’re ready to add your Items to your Unit.  Go 

back to the Status page and click on the Assign subtab.  Click on the Unit you created earlier.  

On the right hand side, click on the By Source subtab.  From the drop down menus, choose your 

Collector and the interface that you’re using to collect.  When you’ve selected those options, click 

on the Show button.  In the list below you will see a list of all of the items that have been 

collected.  Click on the items that you want to add to this unit and then click on the Assign As 

New button (since we haven’t yet assigned an information need to this unit).   

 

 
 

Now, if you look on the left hand side, you’ll see your list of items set as Unit Assigned Items.  

Now all you have to do is assign the Information Need you created earlier to this unit and you will 

see data in your graphs. 
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Assigning the Information Need to the Unit 
 

Staying on the Status tab, click on the View subtab and select your unit from the tree.  On the 

right hand side, select the Details and status icon. 
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This will open the Unit Status window and display an empty GANTT chart with your items listed 

along the side.  From there, click on the Information Needs link under the Definition section.  

 

 
 

From the drop down lists, select the Information Need and the Interface that you are using.  

Be sure that the assign to existing item placeholder(s) radio button is selected.  Then, click 

the Assign button.  

 

 
 

The next step is to view your data in the Portal. 
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View Data in the Portal 
 

Now you’re ready to see your data.  From the Dashboards section, click on one of your items to 

view its data and graphs.  You should see a data point in your graphs for the date that you ran 

the collection.  

 

 
 

For our example, since we were using a manual data entry series for Panned Tasks, we will need 

to edit the data for the graph before an alarm status will show.   

From the Data section, click on Summary to open the Summary View. 
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Enter data for the Planned Tasks series in the Planned Tasks column.  In the example below, the 

data value entered turns the alarm red as can be seen in the Total Tasks column after saving.  
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Be sure the data changes are saved, and return to the graph view from the Dashboards section.   

You should now see Planned Tasks and Total Tasks Alarm on the graph.  

 

Congratulations!  You’ve successfully set up a CSV integration. 
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Contact Information 

 This chapter contains the following topics: 

 

 Contacting IBM Rational Software Support 

 

 Prerequisites 

 

 Submitting problems 

 

 Other information 

 

 

 
Contacting IBM 
Rational Software 

Support 
If the self-help resources have not provided a resolution to your problem, you 

can contact IBM Rational Software Support for assistance in resolving product 

issues.  

 

Note: If you are a heritage Telelogic customer, you can go to 

http://support.telelogic.com/toolbar and download the IBM Rational 

Telelogic Software Support browser toolbar. This toolbar helps 

simplify the transition to the IBM Rational Telelogic product online 

resources. Also, a single reference site for all IBM Rational Telelogic 

support resources is located at 

http://www.ibm.com/software/rational/support/telelogic/ 

 

 

Prerequisites 
To submit your problem to IBM Rational Software Support, you must have 

an active Passport Advantage® software maintenance agreement. Passport 

Advantage is the IBM comprehensive software licensing and software 

maintenance (product upgrades and technical support) offering. You can 

enroll online in Passport Advantage from 

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html. 

 

o To learn more about Passport Advantage, visit the Passport Advantage 

FAQs at 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_ 

quickguides.html. 

o For further assistance, contact your IBM representative. 

To submit your problem online (from the IBM Web site) to IBM Rational 

Software Support, you must additionally: 

o Be a registered user on the IBM Rational Software Support Web site. For 

details about registering, go to http://www-

01.ibm.com/software/support/. 

o Be listed as an authorized caller in the service request tool. 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www-01.ibm.com/software/support/
http://www-01.ibm.com/software/support/
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Submitting 
Problems 

To submit your problem to IBM Rational Software Support: 

 

1.   Determine the business impact of your problem. When you report a 

problem to IBM, you are asked to supply a severity level. Therefore, you 

need to understand and assess the business impact of the problem that 

you are reporting. 

Use the following table to determine the severity level. 

 

Severity Description 

1 The problem has a critical business 

impact: You are unable to use the 

program, resulting in a critical 

impact on operations. This condition 

requires an immediate solution. 

2 This problem has a significant 

business impact: The program is 

usable, but it is severely limited. 

3 The problem has some business 

impact: The program is usable, but 

less significant features (not critical 

to operations) are unavailable. 

 4 The problem has minimal business 

impact: The problem causes little 

impact on operations or a 

reasonable circumvention to the 

problem was implemented. 

 

2.   Describe your problem and gather background information, When 

describing a problem to IBM, be as specific as possible. Include all 

relevant background information so that IBM Rational Software Support 

specialists can help you solve the problem efficiently. To save time, know 

the answers to these questions: 

o What software versions were you running when the problem 

occurred? 

To determine the exact product name and version, use the option 

applicable to you:  

o Start the IBM Installation Manager and select File > View 

Installed Packages. Expand a package group and select a 

package to see the package name and version number.  

o Start your product, and click Help > About to see the offering 

name and version number. 

o What is your operating system and version number (including any 

service packs or patches)?  

o Do you have logs, traces, and messages that are related to the 

problem symptoms?  
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o Can you recreate the problem? If so, what steps do you perform 

to recreate the problem?  

o Did you make any changes to the system? For example, did you 

make changes to the hardware, operating system, networking 

software, or other system components? 

o Are you currently using a workaround for the problem? If so, be 

prepared to describe the workaround when you report the 

problem. 

3.   Submit your problem to IBM Rational Software Support. You can submit 

your problem to IBM Rational Software Support in the following ways: 

o Online: Go to the IBM Rational Software Support Web site at 

https://www.ibm.com/software/rational/support/ and in the Rational 

support task navigator, click Open Service Request. Select the 

electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words. 

For more information about opening a service request, go to 

http://www.ibm.com/software/support/help.html 

You can also open an online service request using the IBM Support 

Assistant. For more information, go to http://www-

01.ibm.com/software/support/isa/faq.html. 

o By phone: For the phone number to call in your country or region, 

go to the IBM directory of worldwide contacts at 

http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region.  

o Through your IBM Representative: If you cannot access IBM 

Rational Software Support online or by phone, contact your IBM 

Representative. If necessary, your IBM Representative can open a 

service request for you. You can find complete contact information for 

each country at http://www.ibm.com/planetwide/. 

 

If the problem you submit is for a software defect or for missing or inaccurate documentation, 

IBM Rational Software Support creates an Authorized Program Analysis Report (APAR). The 

APAR describes the problem in detail. Whenever possible, IBM Rational Software Support 

provides a workaround that you can implement until the APAR is resolved and a fix is 

delivered. IBM publishes resolved APARs on the IBM Rational Software Support Web site daily, 

so that other users who experience the same problem can benefit from the same resolution. 

 

 
Other 

Information 
For Rational software product news, events, and other information, visit 

the IBM Rational Software Web site on 

http://www.ibm.com/software/rational/. 
 

 

http://www.ibm.com/planetwide/
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Notices 
 
This information was developed for products and services offered in the U.S.A.  IBM may not offer 

the products, services, or features discussed in this document in other countries. Consult your 

local IBM representative for information on the products and services currently available in your 

area. Any reference to an IBM product, program, or service is not intended to state or imply that 

only that IBM product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be used 

instead. However, it is the user's responsibility to evaluate and verify the operation of any non-

IBM product, program, or service.   

IBM may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You 

can send written license inquiries to: 

 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

 

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send written inquiries to: 

 

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

 

The following paragraph does not apply to the United Kingdom or any 

other country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 

WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 

LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR 

FITNESS FOR A PARTICULAR PURPOSE. 

 

Some states do not allow disclaimer of express or implied warranties in certain transactions. 

Therefore, this statement may not apply to you.   

 

This information could include technical inaccuracies or typographical errors.  Changes are 

periodically made to the information herein; these changes will be incorporated in new editions of 

the publication. IBM may make improvements and/or changes in the product(s) and/or the 

program(s) described in this publication at any time without notice. 
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Any references in this information to non-IBM Web sites are provided for convenience only and do 

not in any manner serve as an endorsement of those Web sites. The materials at those Web sites 

are not part of the materials for this IBM product and use of those Web sites is at your own risk.  

IBM may use or distribute any of the information you supply in any way it believes appropriate 

without incurring any obligation to you.   

 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) 

the exchange of information between independently created programs and other programs 

(including this one) and (ii) the mutual use of the information which has been exchanged, should 

contact: 

 

Intellectual Property Dept. for Rational Software 

IBM Corporation 

1 Rogers Street 

Cambridge, Massachusetts 02142 

U.S.A. 

 

Such information may be available, subject to appropriate terms and conditions, including in some 

cases, payment of a fee.   

 

The licensed program described in this document and all licensed material available for it are 

provided by IBM under terms of the IBM Customer Agreement, IBM International Program License 

Agreement or any equivalent agreement between us.   

 

Any performance data contained herein was determined in a controlled environment. Therefore, 

the results obtained in other operating environments may vary significantly. Some measurements 

may have been made on development-level systems and there is no guarantee that these 

measurements will be the same on generally available systems. Furthermore, some 

measurements may have been estimated through extrapolation. Actual results may vary. Users of 

this document should verify the applicable data for their specific environment.   

 

Information concerning non-IBM products was obtained from the suppliers of those products, their 

published announcements or other publicly available sources. IBM has not tested those products 

and cannot confirm the accuracy of performance, compatibility or any other claims related to non-

IBM products.  Questions on the capabilities of non-IBM products should be addressed to the 

suppliers of those products. 

 

This information contains examples of data and reports used in daily business operations. To 

illustrate them as completely as possible, the examples include the names of individuals, 

companies, brands, and products. All of these names are fictitious and any similarity to the names 

and addresses used by an actual business enterprise is entirely coincidental.  If you are viewing 

this information softcopy, the photographs and color illustrations may not appear. 
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Trademarks 
IBM, the IBM logo, ibm.com, DOORS, Passport Advantage, and Rational are trademarks or 

registered trademarks of International Business Machines Corp., registered in many jurisdictions 

worldwide. Other product and service names might be trademarks of IBM or other companies. A 

current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html. 

 

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel 

Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel 

Corporation or its subsidiaries in the United States and other countries. 

 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation 

in the United States, other countries, or both. 

 

Other company, product or service names may be trademarks or service marks of others. 

 

http://www.ibm.com/legal/copytrade.html

